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1

PPRREEFFAACCEE  
 
Conventions used in this book. 
 
When asked to use the mouse, you will be directed to click, control-click, right-
click, drag, etc. 
 
 

• click � designates clicking with the left mouse button. 
• control-click � designates holding the Control <CTRL> key down on 

your keyboard and simultaneously clicking with the left mouse button. 
• right-click � designates clicking with the right mouse button. 
• drag � designates dragging/moving the mouse while holding down the 

left mouse button. 
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11  IINNTTRROODDUUCCTTIIOONN  
 
Baird Animator is a versatile 3 dimensional visualization environment for static 
and dynamic datasets.  It was developed by Baird Software, a division of Baird & 
Associates Coastal Engineering. This program is designed to visualize 
bathymetric grids and results files generated by the MMS Plume Model, and 
includes features such as animated flights through the model data and animation 
recording.  The following documentation will guide you through the features and 
utilities the software offers.  
  
 

 
 
 
 



The Baird Animator Environment 

Page   3 

2

22  OOVVEERRVVIIEEWW  OOFF  TTHHEE  BBAAIIRRDD  
AANNIIMMAATTOORR  EENNVVIIRROONNMMEENNTT  

 
The Baird Animator workspace 
environment is broken into 4 
primary control areas to 
optimize the speed and ease 
from which a user can navigate 
the functions of the 
application.  

1. Tree Browser 
2. Property Pages 
3. Layout Window 
4. Toolbars 

Tree Browser 

The Tree Browser operates in tandem with the Property Pages below.  When a 
Tree Browser Item is selected (highlighted) its corresponding properties are 
displayed in the Property Pages.  Other features of the Tree Browser such as 
pop-up menus are described later.  

Property Pages 

The Property Page for a selected Tree Browser Item is used to control the 
attributes of the related item.  This area allows the user to modify a wide range 
of environment variables and change specific features of the selected Property 
Page.  

 Layout Window 

The Layout Window contains three sub-windows, which the user can toggle 
between.  The Design, Preview and World windows give the user 3 different 
perspectives for working with the data and setting up the rendered scene. 

Toolbars 

The Toolbar is designed for quick point and click control of the workspace. 
The handy buttons control some of the more common and practical features of 
the application that allow the user to navigate the workspace in a timely 
fashion.  
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TREE BROWSER 
  
When a user selects an item from the Tree Browser the corresponding property 
page will be displayed below.  A tree item will appear highlighted when selected.  
A plus or minus box that precedes the title of a tree item represents an item which 
contains sub-items.  The sub-item(s) are displayed by default but can be hidden 
from view by a left mouse click over the +/- box of the appropriate parent item. 
 
The Tree Browser contains 2 principle levels: Layout and Figure. Each level 
contains sublevels that control their respective characteristics of the application.  
In the example to the left the Figure is of type VR Scene, which contains a World 
filled with any number of graphical objects. 

 
An additional feature of the Tree Browser is a 
right-clicked activated context-sensitive menu, 
which provides functions appropriate for the 
selected item.  
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PROPERTY PAGES 
 

Common Features 

Note:  When the Auto apply box has been checked 
each change to a Property is immediately applied to 

the workspace.  When the Auto apply box is not selected a number of variables 
can be changed, but the workspace will not reflect these changes until the user 
selects the Apply button.  Undo is only available when Auto Apply is not selected. 
which will revert to the state of the most recent Apply.  The Apply and Undo 
buttons affect all changes made to all property pages. 

 
Color buttons are used to edit the mono-color features of the 
associated property page characteristic. 
 
The Multi-color feature when selected (check box is checked) will 
apply the color palette to associated rendering style.  When the 
Multi color feature is off, the mono-color displayed on the Color 
button is used.   
 
 
Default buttons will restore the original setting of the attribute.  

 

Preferences 

 
Preference property page 
enables the user to modify 
basic navigational settings that 
are primarily used in the World 
Window. 
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Layout Properties 

 
Layout property page allows the 
user to set parameters for 
printing, image capture and 
movie recording format. 
 
Please refer to �Printing, Image 
Capture and Animation 
Recording�. 
 
 
 
 

Flight Path Properties 

Please refer to �Create and Edit a flight path�. 
 

Background Fill Properties 

The Background fill Properties controls the color and style of the background that 
is used when viewing data.  The Solid fill property is a mono color background. 
Fountain fill is a blend of 2-3 colors with the added feature of varying the level of 

blending.  Star fill applies a sky 
of stars over the background 
color.  The user may edit the 
number of stars used to create 
this background style. All 3 
options can be activated at once 
and are rendered in the order 
(Solid, Fountain, Star) as they 
appear on the page. 
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Points Properties 

The Points Properties allows the 
user to edit the variables associated 
with point or XYZ data types.  The 
Points and Squares rendering style 
are toggled functions and can be 
scaled independently.  Both styles 
share the color palette but 
respective mono colors are unique. 

Line Properties 

Similar to the Points Properties the 
Line page allows the user to render 
both Points and Squares styles 
from the ordered line data.  The 
additional feature of this type is 
ability to render the data in Lines 
style.  

Surface Properties 

Surface or TIN data type are 
controlled by the Surface 
Properties.  The page contains 3 
rendering styles: Surface, 
Wireframe, and Contour.  Each of 
the 3 styles can be rendered 
simultaneously and modified 
independently. The Surface style 
enables the user to toggle between 
Facetted and Smooth rendering.  
The Wireframe and Contour style 
share an additional vertical offset 
feature, (Wire/Contour offset) 
which is a useful tool when 
rendering more than one style at a 
time. 
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Palette Properties  

 
The Palette page controls the spectrum for all multi-colored styles of an object 
and, for grid or mesh objects, the number of contour levels as well. 
 

The user can linearly 
interpolate the palette table 
values between the first and 
last values.  Likewise, colors 
are interpolated using HSL 
methods.  
 
Individual values can be 
edited by entering in the input 
fields.  Clicking a color 
button, will pop-up a color 
selector dialog with the added 
feature of adjusting the 
opacity of the color. 

 

Figure Properties  

 
The Figure Properties 
contains 2 basic functions.  
The first is Visible, which 
displays or hides a figure 
from view and output.  The 
second property, Opacity, 
controls the alpha value for 
images.  The additional 
figure feature, Animate, 
controls playback of dynamic 
data. 
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LAYOUT WINDOWS 
 

  
 
The 3 buttons illustrated above, from left to right, toggle the Layout Window 
Area from DESIGN,  PREVIEW & WORLD WINDOWS, 
respectively. 
 

Preview Window 

The Preview Window is the actual layout view of the loaded data that will be used 
for printing, image and animation recording. This window displays the relative 
size and position of the dataspace that was set in the Design Window and the 
aspect ratio (view) of the data controlled in the World Window. 
 

World Window 

This window is the virtual reality world used to handle and manipulate data.  The 
World has 2 primary functions: 

• Modify the 3D view 
• Create and edit flight paths 

 
This window fills the entire work area and thus does not maintain the same aspect 
as the output format. 
 

Design Window 

This window does not actually display the data that has been loaded into the 
workspace but represents each object, data or image, as a sizable box.  The 
primary function of the Design Window is to load, order and position data or 
images as desired.   
 
The design window contains important functions to help the user modify the final 
dataspace that will be used for the specified output format. 
 
The layout window (on the following page) is an illustration of a workspace that 
contains two figures:  

1) Fig 0 � VR Scene  
2) Fig 1 � Image  
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The enumeration of �Fig� represents the order in which the data was added to the 
workspace with 0 denoting the first.  The right-click context-sensitive menu 
functions are as follows: 

1. Insert: inserts data into the workspace 

2. To Back: place the selected figure(s) behind all other figures 

3. Lower: lowers the figure one level 

4. Raises: raises the figure one level 

5. To Front: place the figure in front of all other figures 

6. Clear: clear the �selection� of a figure(s) 

7. Delete: deletes the figure and all associated tree browser items and 
Properties from the workspace. 

 
To modify a figure select the desired object with a left mouse-click.  A selected 
figure will be illustrated by a yellow outline and small square sizing handles at 
each corner.  To move an object press and hold down the left-mouse inside the 
figure area and drag the object to reposition.  To size the figure press and hold 
down the left-mouse over the small square sizing handles at a corner and stretch 
the object to the 
desired size.   
 
For multiple figure 
sizing and positioning 
hold down the [CTRL] 
and use the left-mouse 
to select or de-select 
figures, then size or 
position the grouped 
item as described for 
single figures above. 
Multiple figure 
selections can also be 
done by holding down 
the [SHIFT] key and 
dragging the left-
mouse to outline an 
area that completely 
contains the desired 
figures.  
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TOOLBARS 
 
The toolbar below illustrates all possible features and tools that the user may 
access from this area.  Note that different combinations of control buttons will be 
displayed depending on the editing mode and current layout window from which 
the user is working.  All the buttons below are mouse activated and response is 
immediate, they do not respond in a modal fashion. 
 

 
 

Layout Window Toolbar 

These 3 options, from left to right, set the view window to: 
 

1. Design Window,  
2. Preview Window, 
3. World Window. 

 

 Output Toolbar 

 
The 3 buttons above, from left to right: 
 

1. Movie Record 
2. Image Capture 
3. Print 

 

Animation Control Toolbar 

 
Animation of the camera path is controlled by four buttons on 
the toolbar, which represent REWIND, STEP-BACK, STOP, 
STEP-FORWARD and PLAY, from left to right.   
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View Control Toolbars: 

 

View / Navigation Mode Toolbar 

Above, 3 buttons, from left to right, control the method of view control 
VIEW POINT, FOCAL POINT, and VIEW VECTOR (both VIEW POINT and 

FOCAL POINT), respectively.   
 
 

Distance Tool 

Two Roller controls modify the viewing distance.  The top roller 
is for coarse changes and the lower roller is for finer changes to 

the distance from the Focal Point to the View Point . 
 
 

Flight Path Editor  

This button turns on, or off, the editing of the flight path.  If there is no 
current flight path, a default flight path is quickly applied to the workspace.  

When the button is in the down position the flight path is in edit mode as 
described in the Flight Path section.   
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MOUSE AND KEYBOARD CONTROLS  
 

The functions of the mouse buttons for Baird Animator are as follows:  
• Right button:  used for making context-sensitive menu selections.  
• Left button:  activates all other interaction widgets. 

The keyboard arrows can be used to duplicate the functions of the mouse. 

View Drag and Drop 

This allows you to move the selected view component in XY by clicking with the 
left mouse button and dragging the mouse within the World window.  
 
For the VIEW POINT, dragging up moves the VIEW POINT farther from the FOCAL 
POINT while dragging down moves it closer. Dragging to the left causes a 
counterclockwise rotation while dragging right, clockwise. These effects can be 
combined while dragging by moving the mouse diagonally.  
 
For the FOCAL POINT, dragging works the same way as for the VIEW POINT but 
rather it is the position of the FOCAL POINT that is changed in XY.  
When VIEWING VECTOR (both VIEW POINT-FOCAL POINT) is selected, both 
components are changed simultaneously so dragging works a bit differently. The 
movement of the VIEW POINT and FOCAL POINT together result in the following 
changes to the viewing vector. Dragging down moves the viewing vector forward 
within the dataspace and dragging up moves backward. Dragging left moves the 
scene to the left or the view to the right and dragging right moves the view to the 
left. 
 
By holding down the [CTRL] key while dragging, you can alter the altitude of the 
selected view component. The cursor will appear as a vertical, two-way arrow 
while doing this. Dragging the mouse up moves the selected component down 
while dragging down, moves the component up.  

Shortcut for Rotation 

Viewing the same FOCAL POINT from different VIEW POINT positions is required so 
often that a shortcut for rotating the VIEW POINT has been provided. From the view 
control pop-up menu (in the World Window) select Rotate Clockwise or Rotate 
C-clockwise.  Then select the desired degree of rotation from the common angles 
provided. Selecting an angle rotates the VIEW POINT in the XY plane around the 
FOCAL POINT. This is particularly useful when in an overhead type view.  
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VIEWS 

Pre-Defined Views 

There are two functions that display useful pre-defined views. They are all 
accessible from the pop-up menu from within the World Window. The two preset 
views; Plan View and South View are described below.  

Plan View 

This is a bird�s eye view of the dataspace.  The north direction is pointed 
up, the Focal point is centered, and the entire dataspace is visible. 

South View 

This is the default view when the World window is first presented. This is 
a full-dataspace view from the south. Similar to Plan view, the South View 
displays the north direction pointed up and the Focal point is centered. 

View History 

 
The view history is a stack of previously visited 
views.  An entry is added to the stack each time 
the view is changed. The view history is 
controlled from the keyboard and navigated as 
follows: 

Home key → first stored view 
End key → last stored view 
Page Up → previous stored view 
Page Down → next stored view  

Miscellaneous View Features 

The Reset function in the World Window pop-up 
menu recalculates the world limits and all view 
parameters, then sets the view to a new default 
perspective. This may need to be done whenever 
an object with substantially different coordinates 
is displayed. It is not done automatically you may 
want to preserve the current view.  

Note: 
 
If ever it seems that the 
view has disappeared, it is 
probably the result of 
having two objects with 
greatly differing 
coordinates displayed 
simultaneously. The 
reason for this is that the 
size of the dataspace has 
been enlarged to 
encompass both objects, 
which are relatively very 
small. This situation should 
be avoided. 

!
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MENUS 

 

File Menu 

 

The File menu features are: 

 

Open:     Opens a Baird Animator layout file with extension *.lyt.   

Save:  Stores the present workspace including all data and 
associated properties. 

SaveAs: Identical to Save but the user selects a file name and 
location to store the workspace. 

Print: Prints the contents of the workspace as displayed in the 
Preview Window. 

Snapshot:   Captures an image of the workspace as displayed in the 
Preview window. 

Record:  Creates an animation of the flight path through the 
workspace.  

Exit:   Terminates the application. 

 

View Menu 

 

 The view menu simply allows the user to toggle between 
Design, Preview and World in a similar fashion to the 
buttons found in the toolbar.
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33  WWOORRKKIINNGG  WWIITTHH  BBAAIIRRDD  AANNIIMMAATTOORR  

LOADING DATA 
 
The application has 4 methods to load data into the workspace environment: 
 

1. The File menu 
2. The pop-up menu in the Design Window 
3. The Layout Tree Browser item 
4. Command line 

 
Use the Right mouse to activate pop-up menu from one of 
the first 3 areas listed above. Load the desired data as 
follows: 
 
Select Insert » VR Scene to load model grid files exported 
from SDA, or Insert » Image to load image files.  Next use 
the standard file selector to locate and open the file you 
wish to load into the workspace environment.  Upon a 
successful load a new VR Scene or Image item will appear 
in the Tree Browser and the current viewing window will 
render its respective representation of the data. 
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CREATE AND EDIT A FLIGHT PATH 

 

A flight path is created by storing an ordered series of views that 
are used as control points, which represent specific locations along 
the flight path.  Baird Animator generates flight paths by using the 
control Points to calculate the curve of the path through the 
dataspace. The flight is edited via the pop-up view control menu 
activated by a right mouse click from within the VR Window. 

The current control point for editing purposes will always be 
highlighted in green. 

Control Points are added/deleted/replaced in the list by using the 
corresponding functions located in the pop-up menu.  

To insert Control Points, adjust the view to the desired path starting Point and 
click on either �Add Previous Point� or �Add Next Point�. Whenever a new Point 
is added, it becomes the current control Point. Subsequent additions will be 
inserted either before or after the current Point.  
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Note: You may add additional Points along the present flight path simply by a 
double left mouse click while Pointing to the desired location on the curve. To 
extend the curve simply click beyond the end of the present curve. 

The Delete Current Point will remove the current selected Point from the flight 
path.  Delete All will remove the all the Points, therefore the entire flight path. 
The Replace Current Point function replaces the view associated with the current 
control Point to that of the current view within VR Window. 

The features called Goto �some� Point causes the current view to change to that of 
the selected control point. When the flight path is in edit mode the keyboard can 
be used to navigate through the control points in exactly the same fashion as the 
View History controls described in the previously section. 

Home key → first control point 
End key  → last control point 
Page Up key → previous control point 
Page Down key → next control point 

The Goto Point and keyboard features are most useful for cycling though the 
Points to examine the views in succession. 

The flight path can be rendered 
using a variety of different 
attributes, which are controlled 
from the Flight Path Properties.  

The most important of these 
attributes is the Path Length that 
controls the total number of steps 
or views that will be used in the 
flight path.  The more steps the 
smoother the flight path will 
appear to be.  
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MODIFYING CONTROL POINTS 
Edit the camera path by checking the button Edit box of the Flight Path Property 
Page. 
 
Move the cursor over a control point and click on the point to make it active.  
When you click on a point it will change color to become a green sphere.  Using 
the left mouse button, click and drag the Control Point to the new desired 
position.  As you move the control point, only it�s horizontal XY position 
changes.  Holding down the Control <CTRL> key will constrain the move 
movements to only change the Z (vertical) value of a control point. 

 

DISTRIBUTION OF CONTROL 

POINTS 
Adjusting the spacing between the camera control 
points can vary the speed of the camera�s 
movement through the scene.  By clustering the 
spacing of camera control points it is possible to 
slow the camera�s movement. 
For example, with a starting flight path set to 1000 
frames and 5 control points equally spaced (creating 
4 equal segments), each segment is 250 frames, so 
the camera will move at a constant speed through 
the entire path.  If the path is edited and a new 
control point is added exactly mid-way along the 
last segment, each segment would now represent 
200 frames in the final animation, causing the 
camera to move slower through the last 2 segments. 
The total number of control points can be adjusted at any time when the flight 
path edit feature is on. 
(see property page above) 

250
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OUTPUT: PRINTING, IMAGE CAPTURE AND 

ANIMATION RECORDING 
 
All output format characteristics are managed from the Layout Properties.  The 
Layout page, as with all property dialogue boxes, has modal or non-modal 
functionality. Remember that any changes must be applied (Apply) to the 
environment before they are actually used. 
 

Layout Properties allows the user to 
modify the characteristics for printing, 
image capture and movie recording 
format. 
 
Image Output controls the size (width 
by height in pixels) and image type 
(Format) including extension of the file. 
 
Movie Output controls the number of 
frames that will be recorded from the 
total frames used to create the Flight 
Path. (See Create and Edit Flight Path).   
 
Print Output allows the user to scale the 
output as well as redirects the user to the 
standard Setup controls of the associated 
hardware.  Scaling the output reduces 
the memory required to render the off-
screen bitmap. 
 
Each of the three different output 

utilities can be quickly executed through the Toolbar buttons below.  
Alternatively the user may use the File menu to achieve the same results.   

 
1. Movie Record 
2. Image Capture 
3. Print 

 
The Preview Window illustrates all objects and images in the order, position and 
relative size that they will appear in the desired output format. Note that the 
texture map must be turned off in order to animate or image capture.  
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GGLLOOSSSSAARRYY  
 
 
AVI   � Audio Visual Interlaced, MS Windows format 

BMP   � BitMap 24-bit RGB image 

FLIC  � Flic file is an animation file created by Auto-desk 

FRAMES  � A series of images 

GIF   � Graphic Interchange Format, animated 

JPEG  � Joint Photographics Experts Group 

MNG   � Multi-image Network Graphics 

MPEG  � Motion Pictures Expert Group 

PNG   � Portable Network Graphic 

PPM   � Portable Pixmap 

VR   � Virtual Reality 

 
 
 
 




